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The "KNOW BEFORE YOU GO" section includes important items for your office to review PRIOR 
TO UPDATING to this new version.  Look for screen, table and other changes that might affect your
workflow.   X  Items with a red X are additional important items.

Items marked (Request) were requested by clients and satisfied in the associated update.

Click here to access enhancement details for Documents, EHR Screens and Smart Functions. This 
Content Catalog is evolving, covering changes since Version 12.2, and is updated frequently.

Visit the Education Page for Psych on the Compulink Client website for additional resources.

For any questions or comments regarding this documentation, please email the Documentation 
department at: documentation@compulinkadvantage.com

The topics in the Table of Contents contain links; click a topic to jump to that spot in the document. 
Click on the red page number at the bottom right of the page to return. 
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KNOW BEFORE YOU GO

• PopUp windows now open at the location of your mouse and not the center of the screen.
• This was designed to reduce mouse movement and increase speed.

 X (4/28/2023)(12.7.0.22) Hot Topic >Utility > System Administrator > Menu 
Update

• The System Administrator menu was updated with like items combined:
          • Dictionary Utilities
                    • Maintenance
                    • Pack Individual Table – Introduced in the initial release of version 12.6.
                    • ReIndex Individual Table – Introduced in the initial release of version 12.6.
                    • ReIndex/Recalculate in Bulk – Formerly Utility > Diagnostics.
                    • Utility SQL Scripts
          • License/Software
                    • Download Latest Version
                    • System Password
                    • Update Compulink License/Configuration – Previously ‘Update Configuration’
                    • Workstation Licenses
          • Login
                    • IDs
                    • Profiles
                    • Table Edit Controls
          • Network
                    • Disconnect User
                    • HL-7 Configuration
                    • PracticeWatch Service Install
                    • Show Open Tables
          • System Setup/Configuration
                    • Account Billing/Statements
                    • Appointments 
                    • AP/GL
                    • Credit Card Reader Setup
                    • Deductible Sieve
                    • E-Mail Setup
                    • Fax Setup
                    • Inventory
                    • Ledger
                    • Miscellaneous
                    • New Patient Defaults
                    • Recall
                    • Security/Access
                    • To Do Add Defaults

• The following System Administrator items were removed as NewCrop is no longer used 
   for ERx:
          • E-Rx Setup/Admin > Setup/Admin
          • E-Rx Setup/Admin > Tutorial

 X (4/28/2023)(12.7.0.22) Hot Topic >Utility > System Administrator > System 
Setup/Configuration

• The System Setup window was broken out into individual areas for quick access and they 
   are accessed through: System Setup/Configuration.
• Items are presented with enhanced descriptions for better usability.
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KNOW BEFORE YOU GO
• Account Billing/Statements
          • Contains items previously found on the Acct. Billing and Miscellaneous tabs.
          • Field ‘Meaningful use for all Payors not Just Medicare‘ was moved here from the 
             System Administrator tab.
          • Field ‘Use Claim Set from Previous Encounter’ is a NEW field. See Utility section 
             below for details.
• Appointment
          • Contains items previously found on the Miscellaneous tab.
• AP/GL
          • Contains items previously found on the AP/GL tab.
• Credit Card Reader Setup
          • New window to configure credit card devices.
          • Previously found in Workstation Configuration.
• Deductible Sieve
          • Contains items previously found on the Deductible Sieve tab.
• E-Mail Setup
          • Previously accessed from the main System Administrator menu.
• Fax Setup
          • Previously accessed from the main System Administrator menu.
• Inventory
          • Contains items previously found on the Miscellaneous tab.
• Ledger
          • Contains items previously found on the Miscellaneous tab.
• Miscellaneous
          • Contains items previously found on the Miscellaneous tab.
          • The following items are hidden, as they are still in development: Patient 
             Engagement ? KEY and Org. ID.
• New Patient Defaults
          • Contains items previously found on the Add Defaults tab.
          • The option ‘Agreement Duration’ was removed as Office Agreements are no longer 
             utilized by clients.
• Recall
• Security/Access
          • Contains items previously found on the System Administrator tab.
          • The option ‘Post all PQR items Not Just Medicare’ was moved to ‘Account 
             Billing/Statements’ menu.
• To Do Add Defaults
          • Contains items previously found on the System Administrator tab.

Hot Topics
 X (4/28/2023)(12.7.0.22) Login > Login Window Updated

• When logging into the software, the main menu of the Advantage software does not 
   display until after login.
• This allows for using the full window to display the Compulink Healthcare website with 
   pertinent information.

 X (4/28/2023)(12.7.0.22) Utility > System Administrator > Menu Update

• The System Administrator menu was updated with like items combined:
          • Dictionary Utilities
                    • Maintenance
                    • Pack Individual Table – Introduced in the initial release of version 12.6.
                    • ReIndex Individual Table – Introduced in the initial release of version 12.6.
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Hot Topics
                    • ReIndex/Recalculate in Bulk – Formerly Utility > Diagnostics.
                    • Utility SQL Scripts
          • License/Software
                    • Download Latest Version
                    • System Password
                    • Update Compulink License/Configuration – Previously ‘Update Configuration’
                    • Workstation Licenses
          • Login
                    • IDs
                    • Profiles
                    • Table Edit Controls
          • Network
                    • Disconnect User
                    • HL-7 Configuration
                    • PracticeWatch Service Install
                    • Show Open Tables
          • System Setup/Configuration
                    • Account Billing/Statements
                    • Appointments 
                    • AP/GL
                    • Credit Card Reader Setup
                    • Deductible Sieve
                    • E-Mail Setup
                    • Fax Setup
                    • Inventory
                    • Ledger
                    • Miscellaneous
                    • New Patient Defaults
                    • Recall
                    • Security/Access
                    • To Do Add Defaults

• The following System Administrator items were removed as NewCrop is no longer used 
   for ERx:
          • E-Rx Setup/Admin > Setup/Admin
          • E-Rx Setup/Admin > Tutorial

 X (4/28/2023)(12.7.0.22) Utility > System Administrator > System 
Setup/Configuration

• The System Setup window was broken out into individual areas for quick access and they 
   are accessed through: System Setup/Configuration.
• Items are presented with enhanced descriptions for better usability.

• Account Billing/Statements
          • Contains items previously found on the Acct. Billing and Miscellaneous tabs.
          • Field ‘Meaningful use for all Payors not Just Medicare‘ was moved here from the 
             System Administrator tab.
          • Field ‘Use Claim Set from Previous Encounter’ is a NEW field. See Utility section 
             below for details.
• Appointment
          • Contains items previously found on the Miscellaneous tab.
• AP/GL
          • Contains items previously found on the AP/GL tab.
• Credit Card Reader Setup
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Hot Topics
          • New window to configure credit card devices.
          • Previously found in Workstation Configuration.
• Deductible Sieve
          • Contains items previously found on the Deductible Sieve tab.
• E-Mail Setup
          • Previously accessed from the main System Administrator menu.
• Fax Setup
          • Previously accessed from the main System Administrator menu.
• Inventory
          • Contains items previously found on the Miscellaneous tab.
• Ledger
          • Contains items previously found on the Miscellaneous tab.
• Miscellaneous
          • Contains items previously found on the Miscellaneous tab.
          • The following items are hidden, as they are still in development: Patient 
             Engagement ? KEY and Org. ID.
• New Patient Defaults
          • Contains items previously found on the Add Defaults tab.
          • The option ‘Agreement Duration’ was removed as Office Agreements are no longer 
             utilized by clients.
• Recall
• Security/Access
          • Contains items previously found on the System Administrator tab.
          • The option ‘Post all PQR items Not Just Medicare’ was moved to ‘Account 
             Billing/Statements’ menu.
• To Do Add Defaults
          • Contains items previously found on the System Administrator tab.

 X (4/28/2023)(12.7.0.22) System Administrator > Dictionary Utilities

• The new Dictionary Utilities menu items were renamed for better clarity on functionality:
          • Maintenance
          • Pack Individual Table – Introduced in the initial release of version 12.6.
          • ReIndex Individual Table – Introduced in the initial release of version 12.6.
          • ReIndex/Recalculate in Bulk – Formerly Utility > Diagnostics.
          • Utility SQL Scripts

 X (4/28/2023)(12.7.0.22) Login > Patient Access

• If the user has accessed a patient in the software within the last 2 hours, when they log 
   back into the software, it automatically takes them to the Patient Demographics screen.
• This saves the user an extra click if they have logged out and then logged back in; 
   Example: leaving for lunch and coming back, or going from one Exam room to another.

 X (4/28/2023)(12.7.0.22) Diagnostics > Moved and Renamed

• Diagnostics were moved under the new reorganized menu and renamed.
• It is now found under Utility > System Administrator > Dictionary Utilities > 
   ReIndex/Recalculate in Bulk.

 X (4/28/2023)(12.7.0.22) Patient > Patient Portal Updates

• Several new updates have been made to the Patient Portal that is accessed from 
   mysecurehealthdata.com (Request)
• Upon logging in, a new Help link is displayed above the Copyright.
          • Use this to open the ‘My Secure Health Data Patient Portal’ help manual.
• The title bar at the top now has links to the areas below to allow for easy transition 
   without having to return to the Home screen.
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Hot Topics
          • My Health Records
          • Message My Provider
          • Statements
• The ‘Feedback’ link on the title bar was moved to the new ‘My Account’ drop-down.
• The ‘Settings’ drop-down was changed to ‘My Account’.
          • Some items previously found under ‘Settings’ have been renamed:
                    • Account Profile > Legacy ‘User Information’
                    • Activity > Legacy ‘Activity History’
                    • Authorized Users > Legacy ‘Authorized Representative’
                    • Direct Share > Legacy ‘Recurring Data Sharing’
                    • Session Time-out > Legacy ‘Adjust Time-out Setting’
                    • Request Records Update > Legacy ‘Request Records Update’
                    • Feedback > Previously on the main title bar
                    • Application Registration > Under development
                    • Remove My Account > Legacy ‘Remove My Account’
          • The ‘Check Balance’ option was removed, as this now displays on the title bar.
• My Health Records section
          • Defaults to displaying records for the last 30 days only to allow for quicker loading.
          • The ‘View’ option allows for selecting a wider date range for viewing.
• Message My Provider section
          • The user’s name displays at the top and offers a drop-down to select another 
             patient connected to the same E-Mail.
          • The user can send a message to the Provider on behalf of another user.
          • If another option is selected from the title bar (Example: My Health Records), it 
             reverts back to the user that is logged in, preventing them from viewing 
             information for the other user.
• Statements section
          • No changes.

 X (4/28/2023)(12.7.0.22) Exam > Appropriate Use Criteria > Information

• Background
          • The Protecting Access to Medicare Act (PAMA) of 2014, Section 218(b), established
             a new program to increase the rate of appropriate advanced diagnostic imaging 
             services provided to Medicare beneficiaries.
          • Under this program, at the time a practitioner orders an advanced diagnostic 
             imaging service for a Medicare beneficiary, he/she, or clinical staff acting under 
             his/her direction, will be required to consult a qualified Clinical Decision Support 
             Mechanism (CDSM).
                    • CDSMs are electronic portals through which Appropriate Use Criteria (AUC) 
                       is accessed. 
                    • The CDSM provides a determination of whether the order adheres to AUC, 
                       or if the AUC consulted was not applicable (e.g., no AUC is available to 
                       address the patient’s clinical condition). 
                    • A consultation must take place at the time of the order for imaging services 
                       that will be furnished in one of the below settings and paid for under one of
                       the below payment systems. 
                    • Ultimately, practitioners whose ordering patterns are considered outliers will
                       be subject to prior authorization. 
                    • Information on outlier methodology and prior authorization is not yet 
                       available. (As of 12/14/2022)

• Who is Affected by the Program?
          • This program impacts all physicians and practitioners that order advanced 
             diagnostic imaging services and physicians, practitioners and facilities that furnish 
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Hot Topics
             advanced diagnostic imaging services in a physician’s office, hospital outpatient 
             department (including the emergency department), an ambulatory surgical center 
             or an independent diagnostic testing facility (IDTF) and whose claims are paid 
             under the physician fee schedule, hospital outpatient prospective payment system 
             or ambulatory surgical center payment system.

• What does Advanced Diagnostic Imaging Include?
          • Computed tomography (CT)
          • Positron emission tomography (PET)
          • Nuclear medicine
          • Magnetic resonance imaging (MRI)

• Where Can I Find More Information?
          • https://www.cms.gov/Medicare/Quality-Initiatives-Patient-Assessment-
Instruments/Appropriate-Use-Criteria-Program

• What is Compulink Doing?
          • We are interfacing with Change Healthcare’s ‘Care Select’ product for AUC.
          • New fields were added to the following databases:
                    • ExamTest
                    • Test
          • AUC panels were added to appropriate tabs.

 X (4/28/2023)(12.7.0.22) Exam > Appropriate Use Criteria > Setup

• If you will be ordering Radiology Tests from the Advantage software, you must complete 
   setup in the following tables:
          • Financial > Modifiers
          • EHR > Test > Name

• Financial > Modifiers
          • Enter the following items into the table:
                    • MA-Emergency Medical Condition
                    • MB-Hardship Exception/Internet
                    • MC-Hardship Exception/Vendor
                    • MD-Hrdshp Excptn/UncontrolCirc
                    • ME-Adheres to AUC
                    • MF-Does Not Adhere to AUC
                    • MG-No AUC available
                    • MH-AUC info not provided
                    • QQ-Consulted AUC/Data provided

• EHR > Test > Name
          • Edit User-owned Radiology records; Compulink-owned records are automatically 
             populated for you.
          • In the Radiology AUC field, click the drop-down and select the most appropriate 
             match to the Test Name.

 X (4/28/2023)(12.7.0.22) Login > Valid E-Mail

• For Login IDs with Owner, Manager or Provider checked, their Primary E-Mail address is 
   validated upon Login.
• If the Primary E-Mail field in the Login IDs table is not in a valid format, a window opens 
   with the non-valid E-Mail, and prompts them to enter an E-Mail in the correct format.
• Once entered, the user is logged in, and the Login IDs table is automatically updated.
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Hot Topics
 X (4/28/2023)(12.7.0.22) General > Display > Buttons Moved

• With the new GI update that began with version 12.6, many of the buttons found on 
   panels throughout the software, have now been moved to the ellipsis hover menu.

 X (4/28/2023)(12.7.0.22) General > Display > PopUpPlacement

• PopUp windows now open at the location of your mouse and not the center of the screen.
• This was designed to reduce mouse movement and increase speed.

 X (5/12/2023)(12.7.0.22) Education > University Single Sign-On > Cloud

• Single Sign-On to the courses in Compulink University is now available for clients in the 
   Cloud environment. (Request) 
• You must contact Compulink Support to assist you with installing a file on your local 
  computers that will be using this feature.
• Once installed, log onto your remote session, launch the Advantage software and log in.
• Click the Help icon and select ‘Compulink University/Learn’.
• This takes you directly to the University and automatically logs you in based upon your 
   Compulink Login ID.

 (5/8/2023)(12.7.0.22) EHR > Data Entry > Real Time Note Update Engine

• A NEW feature called ‘Real Time Note Update Engine’ was added. (Request)
• This engine allows the user to create an entire note to pull into a patient’s record, 
   inserting specifics where needed.
          • Example: Pull in the note and allow entry for patient specific area, measurement, 
             incision length, etc.

Education

Education
 (6/6/2023)(12.7.0.22) Video > NEW: Data Mining: Adding an SQL Query

• The Compulink University course 'Data Mining: Adding an SQL Query’ was added.
• It can be found under the following Program: Practice Admin
• Course Description: Review fields and options when adding an SQL Query.
• Published: 5/10/23 - Length: 12 Minutes

 (6/6/2023)(12.7.0.22) Video > NEW: Data Mining: Wizard

• The Compulink University course 'Data Mining: Wizard’ was added.
• It can be found under the following Program: Practice Admin
• Course Description: Learn how to use the Wizard to create an SQL Script.
• Published: 5/10/23 - Length: 10 Minutes

 (6/6/2023)(12.7.0.22) Video > NEW: Dictionary Utilities

• The Compulink University course 'Dictionary Utilities’ was added.
• It can be found under the following Program: About Version 12.7
• Course Description: This course reviews the System Administrator Dictionary Utilities in 
   V12.7 and greater.
• Published: 4/24/23 - Length: 18 Minutes

 (5/12/2023)(12.7.0.22) Video > NEW: Data Mining: Overview

• The Compulink University course 'Data Mining: Overview’ was added.
• It can be found under the following Program: Practice Admin
• Course Description: Review options in Data Mining and run an SQL Script.
• Published: 5/10/23 - Length: 11 Minutes

 (5/12/2023)(12.7.0.22) Video > NEW: Overview: System Administrator Utilities 
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Education
V12.7

• The Compulink University course 'Overview: System Administrator Utilities V12.7’ was 
   added.
• It can be found under the following Program: System Admin
• Course Description: Review the utilities located under the System Administrator menu in 
   V12.7/greater.
• Published: 5/10/23 - Length: 4 Minutes

 (5/12/2023)(12.7.0.22) Video > NEW: System Setup: AP/GL

• The Compulink University course 'System Setup: AP/GL’ was added.
• It can be found under the following Program: System Admin
• Course Description: Learn the field definitions related to Accounts Payable and General 
   Ledger settings in Version 12.7/greater.
• Published: 5/10/23 - Length: 4 Minutes

 (5/12/2023)(12.7.0.22) Video > NEW: System Setup: Acct Billing/Statements

• The Compulink University course 'System Setup: Acct Billing/Statements’ was added.
• It can be found under the following Program: System Admin
• Course Description: Review settings for account billing including statement messages, 
   finance charges, overdue letters and collection in V12.7/greater.
• Published: 5/10/23 - Length: 12 Minutes

 (5/12/2023)(12.7.0.22) Video > NEW: System Setup: Appointment

• The Compulink University course 'System Setup: Appointment’ was added.
• It can be found under the following Program: System Admin
• Course Description: Learn about the Appointment Scheduler configuration options in 
   V12.7/greater.
• Published: 5/10/23 - Length: 6 Minutes

 (5/12/2023)(12.7.0.22) Video > NEW: System Setup: Deductible Sieve

• The Compulink University course 'System Setup: Deductible Sieve’ was added.
• It can be found under the following Program: System Admin
• Course Description: Learn about Deductible Sieve parameters that may be used to hold 
   claims based on the patient’s unmet deductible amount in V12.7/greater. 
• Published: 5/10/23 - Length: 3 Minutes

 (5/12/2023)(12.7.0.22) Video > NEW: System Setup: E-Commerce

• The Compulink University course 'System Setup: E-Commerce’ was added.
• It can be found under the following Program: System Admin
• Course Description: Configure E-Commerce settings associated with MyEyeStore 
   activation, patient messaging, discounts and shipping fees in V12.7/greater.
• Published: 5/10/23 - Length: 4 Minutes

 (5/12/2023)(12.7.0.22) Video > NEW: System Setup: Fax Setup

• The Compulink University course 'System Setup: Fax Setup’ was added.
• It can be found under the following Program: System Admin
• Course Description: Review the setup required to send/receive electronic faxes with your 
   Advantage software using Updox in V12.7/greater.
• Published: 5/10/23 - Length: 4 Minutes

 (5/12/2023)(12.7.0.22) Video > NEW: System Setup: Inventory

• The Compulink University course 'System Setup: Inventory’ was added.
• It can be found under the following Program: System Admin
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Education
• Course Description: Set defaults to control sales tax posting and billing and the display of 
inventory cost in V12.7/greater.
• Published: 5/10/23 - Length: 2 Minutes

 (5/12/2023)(12.7.0.22) Video > NEW: System Setup: Ledger

• The Compulink University course 'System Setup: Ledger’ was added.
• It can be found under the following Program: System Admin
• Course Description: Configure Account Ledger settings for batch posting, claim validation,
   diagnosis, post dating, ‘stop on’ fields and more in V12.7/greater.
• Published: 5/10/23 - Length: 4 Minutes

 (5/12/2023)(12.7.0.22) Video > NEW: System Setup: Miscellaneous

• The Compulink University course 'System Setup: Miscellaneous’ was added.
• It can be found under the following Program: System Admin
• Course Description: Set defaults for customizing data entry and assigning security 
   controls to different areas of your patient records.
• Published: 5/10/23 - Length: 6 Minutes

 (5/12/2023)(12.7.0.22) Video > NEW: System Setup: New Patient Defaults

• The Compulink University course 'System Setup: New Patient Defaults’ was added.
• It can be found under the following Program: System Admin
• Course Description: Learn about default values that can be applied to all new patient 
   accounts when created. 
• Published: 5/10/23 - Length: 3 Minutes

 (5/12/2023)(12.7.0.22) Video > NEW: System Setup: Recall

• The Compulink University course 'System Setup: Recall’ was added.
• It can be found under the following Program: System Admin
• Course Description: Set defaults for patient Recall such as Reminder to schedule and 
   ignoring patients with future Appointments in V12.7/greater.
• Published: 5/10/23 - Length: 2 Minutes

 (5/12/2023)(12.7.0.22) Video > NEW: System Setup: Security/Access

• The Compulink University course 'System Setup: Security/Access’ was added.
• It can be found under the following Program: System Admin
• Course Description: The Security/Access area is used to establish practice rules related to
   User Passwords and System Audits in V12.7/greater.
• Published: 5/10/23 - Length: 7 Minutes

 (5/12/2023)(12.7.0.22) Video > NEW: System Setup: To Do Add Defaults

• The Compulink University course 'System Setup: To Do Add Defaults’ was added.
• It can be found under the following Program: System Admin
• Course Description: Learn to assign action items or reminders to perform tasks related to 
   every new patient added in V12.7/greater.
• Published: 5/10/23 - Length: 3 Minutes

 X (4/28/2023)(12.7.0.22) User-Focused Education > Entry Order

• The Education items are sorted in the following order:
          • By Version, newest to oldest, and grouped by build number, e.g. 12.5.0.20 and 
             12.5.0.18.
          • Not Reviewed (within that Version)
          • Priority (within that Version)
          • Subject (within that Version)
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Education
 X (4/28/2023)(12.7.0.22) User-Focused Education > Review Time

• The User-Focused Education that is accessed from the graduation cap icon on the bottom 
   taskbar now tracks the time that the user used to review an entry.

• Review Time:
          • The functionality requires a minimum number of seconds to view each line.
                    • Example: 10 lines in the message requires longer review time than 2 lines.
          • If you edit an item and don’t hit the minimum seconds, when you Save, the 
             following message displays: Press YES to CONFIRM you spent less than X seconds 
             viewing content or NO to continue viewing!
          • This was added to deter staff from just opening the item, clicking Save and not 
             reviewing the information.

 (4/28/2023)(12.7.0.22) Video > NEW: AUC: Table Setup And Exam Functionality

• The Compulink University course 'AUC: Table Setup And Exam Functionality’ was added.
• It can be found under the following Program: About Version 12.7
• Course Description: Learn what table setup is required for Appropriate Use Criteria and 
how AUC functions in the exam screens.
• Published: 4/24/23 - Length: 9 Minutes

 (4/28/2023)(12.7.0.22) Video > NEW: V12.7 Know B4 You Go: Buttons Moved to 
Hover Menus

• The Compulink University course 'V12.7 Know B4 You Go: Buttons Moved to Hover Menus’
   was added.
• It can be found under the following Program: About Version 12.7
• Course Description: GUI updates moved the functionality from on screen buttons to hover
   menus in several areas throughout the software.
• Published: 4/24/23 - Length: 3 Minutes

 (4/28/2023)(12.7.0.22) Video > NEW: V12.7 Know B4 You Go: System Admin 
Utilities

• The Compulink University course 'V12.7 Know B4 You Go: System Admin Utilities’ was 
   added.
• It can be found under the following Program: About Version 12.7
• Course Description: View V12.7 improvements to the System Administrator Utilities.
• Published: 4/12/23 - Length: 4 Minutes

 (4/28/2023)(12.7.0.22) Video > NEW: What Is New In V12.7

• The Compulink University course 'What Is New in V12.7’ was added.
• It can be found under the following Program: About Version 12.7
• Course Description: Learn about software updates/enhancements beginning with V12.7
• Published: 4/5/23 - Length: 11 Minutes

Appointment

Appointment > General Changes
 (5/5/2023)(12.7.0.22) Display > Follow Provider

• When selecting a date, the calendar follows the Provider on the active date to the new 
   date selected. (Request) 
• Example: 
          • Date is 05/02/23 and Provider is DRD.
          • Click the drop-down at Date field and select 05/05/23.
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Appointment > General Changes
          • Daily Detail screen changes to the new date and Provider is DRD.
          • If the Provider doesn’t have a template scheduled for that day, it displays blank.
          • Previous versions would switch to another Provider that did have a schedule.

Appointment > Commands
 (5/23/2023)(12.7.0.22) Next > Follow Location/Provider

• When clicking Next, the software follows either the Location, Provider or both. (Request) 
• The functionality is controlled by the new setting ‘Next Selection Behavior’ under Utility > 
   System Administrator > System Setup/Configuration > Appointment.

 (4/28/2023)(12.7.0.22) Utility > Reasons > Code Removed

• The 1-character Code field was removed, as it is legacy and no longer used in scheduling 
   or reporting.

 (4/28/2023)(12.7.0.22) Utility > Template Schedule > Calendar Display

• The calendar at the top of the window only displays when selecting Duplicate > Calendar.

Communication
 (7/10/2023)(12.7.0.22) InBox > RCM POC Contact Message > Outstanding Claim 

Errors

• A new InBox message and E-Mail are sent daily to the RCM (Revenue Cycle Management)
   Point of Contact if the amount of pending claims with errors is greater than $10.
          • This person is entered under Ledger > Options > Update RCM Configuration.
          • If the contact person is not established here, the daily message does not go out.
• The message is only to raise awareness and does not perform any functionality.
• The message/E-Mail contains the following information:
          • Subject: $XX.XX in Pending Claims Unable to be Billed by Compulink RCM Team! 
             (where XX.XX is replaced with the practice’s outstanding amount).
          • Body: Total of Overdue Pending Claims being Held Requiring Your Staff’s Attention 
             BEFORE Compulink Billing Service Team can Submit Claims!
• Staff should run the worklist ‘Claim Edit Errors’ for a list of errors to correct.

 (4/28/2023)(12.7.0.22) Messages Upon Login > ACCESS DENIED

• If running Advantage Database Server version 12, a new online ReIndexing is available.
• This allows index only Diagnostics to run with users in the software.
• If other process are running that prevent launching, the message was updated to the 
   following: ACCESS DENIED: Version Update, Maintenance, or Table Structure changes in 
   process at another station which requires Exclusive Access to Dictionary!
• The reference to Diagnostics was removed, since you may now run them with other users
   in the software.

 (4/28/2023)(12.7.0.22) Owner Messages > InBox and E-Mail

• The messages below are currently sent to the InBox of the Login IDs flagged as ‘Owner’.
• If a Primary E-Mail is listed, they will also be sent to the user’s E-Mail address.
• Owner Messages:
          • EDI Utilization Opportunities
          • Revenue Opportunity Report
          • RCM Practice Benefit
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Customization
 (4/28/2023)(12.7.0.22) Screen Builder > ALL > Discontinued

• If Compulink discontinues a Compulink-owned layout or tab, upon update, that item is 
   automatically changed to User-owned (no Discontinued date).

EDI (Electronic Billing)
 (5/5/2023)(12.7.0.22) Function > Insurance Activities > Remittance Posting

• If the Electronic Remittance includes a charge that was 100% denied, adjustments on 
   other charges for that claim are now auto-posted to reduce manual work.
• In previous versions, when there was a denied charge, no other adjustments were 
   posted, and had to be done manually. (Request)

Exam

Exam > General & Display Changes
 (4/28/2023)(12.7.0.22) General > Appropriate Use Criteria > Functionality

• A new AUC panel was added to appropriate PopUp tabs in your Advantage product.
• AUC information must be retrieved by the ORDERING Provider and supplied to the facility 
   performing the Test.

• Adding the Radiology Order:
          • A Radiology record may be added automatically via Order Sets, or manually on 
             your designated tab for adding Radiology orders.
          • Edit the record and verify that the following fields are populated:
                    • Test Name
                    • Side (if appropriate)
                    • Diagnosis pointer in the Diag field

• Access the AUC website:
          • On the same PopUp window, go to the AUC – Appropriate Use Criteria panel.
          • Hover over the ellipsis and choose Care Select.
          • This opens the Web Browser with the following information:
                    • The Test that you selected displays at the top of the screen.
                    • The Diagnosis pointer displays in the search field under the Test.
                    • Results display on the left for items focused and related to the Diagnosis.
                              • Select a check box(s) to the left of the most appropriate result.
                    • To the right on the top, it displays the patient age and gender.
                    • Below this, it displays the requested Test that you entered, along with any 
                       additional Tests that are appropriate for the patient age/gender/diagnosis.
                    • Each Test displays the following:
                              • Name
                              • Number designating appropriateness
                              • Color coded
                                        • Red = Usually not appropriate
                                        • Yellow = May be appropriate 
                                        • Green = Usually appropriate
                              • Dollar sign(s) represent the cost of the test
                              • Radiology symbol(s) based on the amount of radiology the test 
                                 subjects the patient to
          • Choosing the Test/Order
                    • Existing Test ordered:
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Exam > General & Display Changes
                              • On the existing test at the top, you can click ‘Cancel Order’ to 
                                 cancel and go back to the Advantage software.
                              • After reviewing all options, if you choose to keep the existing Test, 
                                 click the ‘Confirm & Order’ button.
                    • Selecting a suggested Test:
                              • If you choose to select a different Test, click ‘Replace & Order’ to the 
                                 right of the Test.
          • No Match Found
                    • If the Web Browser opens and states that your search was not matched to 
                       any indications, click the following: ! I Can’t Find a Match.
                    • A window opens for you to provide details on why you are ordering the Test.
                    • Click ‘Yes, Submit Order’.
                    • This populates the Clinical Decision memo field on the AUC panel.

• Viewing information on the Advantage PopUp window:
          • Once you select a Test, you are taken back to the PopUp window in the Advantage 
             software.
                    • If you selected to replace the original Order, the new information is 
                       displayed in the Test field.
          • The following information displays in the AUC panel:
                    • Modifier – Appropriate modifier to submit on your claim.
                    • G Code – Appropriate G Code to submit on your claim.
                    • CDS# - Clinical Decision Support Number indicating that the information 
                       was pulled using the AUC Criteria.
                              • This is required for auditing purposes.
                    • Clinical Decision – This is a memo field that is populated if no match was 
                       found and details were entered on why the Test was ordered.
          • Enter any other appropriate information in the PopUp and save.

• Print the Radiology Order:
          • On the Test panel, highlight the ellipsis and select Print Radiology Order; this might
             be slightly different depending upon the Advantage product.
          • The following information displays under the Orders section:
                    • Appropriate Use Criteria
                    • Modifier
                    • G Code
                    • CDS
                    • Clinical Decision memo field (if populated)
          • Submit this information to the facility performing the Test.

• Marking Test Performed and Posting Charges:
          • Once the Test has been performed, edit the record, mark as Performed and Save.
          • Click the Fees command.
          • You will see the following lines:
                    • Test/Order – Includes Name, CPT, Modifier(s) and Diagnosis pointer.
                    • Appropriate Use Criteria – Includes CPT and Diagnosis pointer.
          • Select either Post to post to the Ledger or Save for Ledger to post later.

 (4/28/2023)(12.7.0.22) General > Data Entry > Memo Fields > Cursor Placement

• Right click in a memo field and select Note Lookup Table to open the EHR Notes table.
• Select an option from the table to populate the field and the cursor is placed at the end of
   the selection. (Request) 
• This works the same if there is a Smart Function attached to double clicking in the field to
   open a filtered EHR Notes table and making a selection.
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Exam > Commands
 (5/5/2023)(12.7.0.22) Images > View Selected > Display Order

• Images now display the most recent image to the oldest image. (Request)

 (4/28/2023)(12.7.0.22) MACRA > Reconcile Pending CCD > 
Medication/Allergy/Problem

• Medication, Allergy and Problem are listed on the right side of the ‘Reconciling CCD’ 
   window.
• Double click on the yellow header at the top to mark ALL entries as ‘Yes’ in all 3 grids. 
   (Request) 
• Double click on a single entry to change back to ‘No’.

 (6/1/2023)(12.7.0.22) Print > Letter > ADDED: See Below

• The following NEW letter was added:
          • ExamAHCHRSN – Accountable Health Communities Health-Related Social Needs 
             Screening

 (4/28/2023)(12.7.0.22) Print > Letter > Window Updated

• The following updates were made:
          • GUI changes to display rounded panels and fields.
          • NEW Document and Options panels.
          • The OK button was replaced with a Proceed button on the command bar.
          • The Cancel button was removed, as you can use the X in the top right to cancel 
             and close the window.

 (4/28/2023)(12.7.0.22) Print > Selected > Window Updated

• The following updates were made:
          • GUI changes to display rounded panels and fields.
          • NEW Multi-Select and Options panels.
          • The OK button was replaced with a Proceed button on the command bar.
          • The Cancel button was removed, as you can use the X in the top right to cancel 
             and close the window.

Exam > E-Rx
 (4/28/2023)(12.7.0.22) E-Rx > Pharmacy > Preferred List

• Accessing the Pharmacy list displays the preferred (most used by the office) Pharmacies 
   at the top of the list.
• To make searching easier, these now display in alphabetical order (previously in usage 
   order). (Request)

Exam > Fees
 (6/1/2023)(12.6.0.17) Fees > EHR Auto Fee Posting Window > Management 

Level Determination

• An update was made to the 2021 E&M Coding Engine for determining the 
   Surgery/Treatment item for the Management Level Determination.
• In previous versions, the software looked for the CPT on a Surgery for Global Period to 
   determine the Surgery level.
          • If Global period is 0-10 days, then Minor Surgery.
          • If 11 days or greater, then Major Surgery.
• If a Surgery record is not found, the software now looks for a Care Plan record.
          • The Provider may spend time discussing the Surgery with the patient, and then the
             patient chooses not to move forward with it.
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Exam > Fees
          • In this case, the Provider still gets “credit” for discussing the Surgery.
• Surgery Level Determination via Care Plan:
          • The encounter contains a Care Plan record with Intent=’Proposed’ and Status=’On 
             Hold’.
          • From these records, the ‘Major’ field is reviewed:
                    • If ‘Major’ is checked, level is Major.
                    • If the field is blank, level is Minor.
          • From these same records, the ‘High Risk’ note field is reviewed:
                    • If the field IS NOT empty, then the Risk Factor is ‘True’.
                    • If the field IS empty, then the Risk Factor is ‘False’.
          • Level Determination:
                    • If ‘Major’ and Risk Factor of True = Level 4
                    • If ‘Minor’ and Risk Factor of True = Level 3
                    • If ‘Minor’ and Risk Factor of False = Level 2
                    • All else = Level 1

 X (4/28/2023)(12.7.0.22) Fees > EHR Auto Fee Posting Window > Window 
Updated

• The following updates were made:
          • GUI changes to display rounded panels and fields.
          • Header
                    • New items added:
                              • Post – Previously Post button
                              • Save for Ledger - Previously Save for Ledger Posting button
                                        • When clicked, the window closes back to the Exam screen.
          • Post Options panel
                    • New panel added and the following items were moved to it:
                              • ID – Previously Provider ID
                              • Aux – Previously Aux. ID
                              • Dept
                              • Posting message
          • Services & Diagnosis panel
                    • New panel added and the following items were moved to it:
                              • Services list
                              • Diagnosis list
          • Results panel
                    • New panel added and the following items were moved to it:
                              • E and M Level coding
                              • Internal Counts and Logical Values memo and list

Exam > Layouts & Tabs
 (4/28/2023)(12.7.0.22) Layout(s) > EDITED: MH First Visit

• The following tab was added to the layout: 
          • Tab Name: Personal Assessment, Tab Label: Evaluation

 (4/28/2023)(12.7.0.22) Tab(s) > ADDED: Personal Assessment

• Tab Name: Personal Assessment
• Tab Label: Evaluation

• Created for 1 tab to enter all patient history. (Request)
• Contains the following panels:
          • History and Psychosocial
          • Summary
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Exam > Layouts & Tabs
• This NEW tab was added to the MH First Visit layout.

• History and Psychosocial panel:
          • Each label has a Smart Function attached.
          • Click to open the GridEdit window to enter information for the specified history.

• Summary panel:
          • Defaults to display all of the history items entered via the History and Psychosocial
             panel GridEdits.
          • The ellipsis hove menu contains filter options based on the history.
                    • Highlight the ellipsis, highlight Filter and select an option to filter the 
records 
                       that display in the grid.
                    • The Filter also contains options for Episode and All.
                              • Select Episode to filter by Episode of Care (if applicable).
                              • Select All to display all history records if you had previously selected 
                                a specific filter.

 (4/28/2023)(12.7.0.22) Tab(s) > ADDED: Quality Measures 2023

• Tab Name: Quality Measures 2023
• Tab Label: Quality23

• This tab was added for 2023 Meaningful Use Measures.
• It contains the following panels:
          • #047: Advance Care Plan (CLINICAL SOCIAL WORKER ONLY)
          • #128: Preventive Care and Screening: BMI Screening and Follow-Up Plan
          • #130: Documentation of Current Medications in the Medical Record
          • #134: Preventive Care and Screening: Screening for Depression and Follow-Up 
             Plan
          • #181: Elder Maltreatment Screen and Follow-Up Plan
          • #226: Preventive Care and Screening: Tobacco use: Screening and Cessation 
             Intervention
          • #282: Dementia: Functional Status Assessment
          • #283: Dementia Associated Behavioral and Psych Symptoms Screening and 
             Management
          • #286: Dementia: Safety Concern Screening and Follow-Up for Patients with 
             Dementia
          • #288: Dementia: Education and Support of Caregivers for Patients with Dementia
          • #317: Preventive Care and Screening: High Blood Pressure and FU Documented
          • #370: Depression Remission at Twelve Months
          • #383: Adherence to Antipsychotic Medications For Individuals with Schizophrenia
          • #391: Follow-Up After Hospitalization for Mental Illness (FUH)
          • #402: Tobacco Use and Help with Quitting Among Adolescents
          • #431: Preventive Care and Screening: Unhealthy Alcohol Use: Screening and Brief
            Counseling
          • #468: Continuity of Pharmacotherapy for Opioid Use Disorder (OUD)
          • #487: Social Drivers: food insecurity, housing instability, transportation needs, 
             utility difficulties, and interpersonal safety
          • #AHC HRSN Screening Tool

 (4/28/2023)(12.7.0.22) Tab(s) > ADDED: Quality Measures 2023 (HiRes)

• Tab Name: Quality Measures 2023 (HiRes)
• Tab Label: Quality23
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Exam > Layouts & Tabs
• This tab was added for 2023 Meaningful Use Measures.
• It contains the following panels:
          • #047: Advance Care Plan (CLINICAL SOCIAL WORKER ONLY)
          • #128: Preventive Care and Screening: BMI Screening and Follow-Up Plan
          • #130: Documentation of Current Medications in the Medical Record
          • #134: Preventive Care and Screening: Screening for Depression and Follow-Up 
             Plan
          • #181: Elder Maltreatment Screen and Follow-Up Plan
          • #226: Preventive Care and Screening: Tobacco use: Screening and Cessation 
             Intervention
          • #282: Dementia: Functional Status Assessment
          • #283: Dementia Associated Behavioral and Psych Symptoms Screening and 
             Management
          • #286: Dementia: Safety Concern Screening and Follow-Up for Patients with 
             Dementia
          • #288: Dementia: Education and Support of Caregivers for Patients with Dementia
          • #317: Preventive Care and Screening: High Blood Pressure and FU Documented
          • #370: Depression Remission at Twelve Months
          • #383: Adherence to Antipsychotic Medications For Individuals with Schizophrenia
          • #391: Follow-Up After Hospitalization for Mental Illness (FUH)
          • #402: Tobacco Use and Help with Quitting Among Adolescents
          • #431: Preventive Care and Screening: Unhealthy Alcohol Use: Screening/Brief 
            Counseling
          • #468: Continuity of Pharmacotherapy for Opioid Use Disorder (OUD)
          • #487: Social Drivers: food insecurity, housing instability, transportation needs, 
             utility difficulties, and interpersonal safety
          • #AHC HRSN Screening Tool

 (4/28/2023)(12.7.0.22) Tab(s) > EDITED: PopUpCarePlan

• Tab Name: PopUpCarePlan
• Tab Label: Care Plan

• Care Plan panel
          • High Risk – This is a NEW notes field added for documenting High Risk notes.
          • Field Defaults - Upon selection from the Name drop-down, the following fields 
             default based upon data entered in the Care Plan table: 
                    • Name
                    • Category
                    • Details
                    • Status
                    • Intent
                    • Major – Defaults from the table, but does NOT display on the screen. 
                              • Designates if the Care Plan is for a Major Treatment/Surgery. 
                              • True indicates Major and False indicates Minor. 
                              • Added for E&M Coding changes.
          • High Risk for E&M Coding Calculation
                    • A NEW ‘High Risk’ memo field was added.

• High Risk for E&M Coding Calculation
          • Health History items:
                    • If Health History items are checked as High Risk, when a Care Plan is added
                       and the 'Name' is selected, a window opens with all High Risk items 
                       indicated during that encounter.
                    • If one of the items is High Risk for the Care Plan record that is being 
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Exam > Layouts & Tabs
                       displayed in the header of the window, double click on that item; if not, hit 
                       the Escape key or click the 'X' to close the window.
                    • If a High Risk item is selected, the 'Identify High Risk Reasons' memo field 
                       opens, and the item selected defaults into the data area for additional 
                       documentation.
                    • Save the window and the additional documentation displays in the 'High 
                       Risk' Notes field for reference.
          • High Risk Care Plan:
                    • If the Provider discusses a major or minor Procedure/Surgery or Treatment 
                       with the patient, and the patient does not choose to move forward, you 
                       must select one of the following Care Plans:
                              • Major Surgery Discussion
                              • Minor Surgery Discussion
                              • Major Treatment Discussion
                              • Minor Treatment Discussion
                    • The E&M Coding Engine looks at this field and coding guidelines to justify a 
                       major or minor Procedure/Surgery or Treatment discussion in 
                       recommending the appropriate level of service.

 (4/28/2023)(12.7.0.22) Tab(s) > EDITED: See Below

• The change below was made to the following tabs:
          • Tab Name: HiResSessNoteMH, Tab Label: Sess Note
          • Tab Name: HiResSessNotePsych, Tab Label: Psych Note

• Left panel
          • Hx/Behavior button
                    • The Smart Function attached was updated. When clicked, it adds the NEW 
                       tab Personal Assessment to the end of the layout.

 (4/28/2023)(12.7.0.22) Tab(s) > EDITED: See Below

• The change below was made to the following tabs:
          • Tab Name: HiResSessNoteMH, Tab Label: Sess Note
          • Tab Name: Service Plan, Tab Label: Serv Plan
          • Tab Name: Therapy, Tab Label: Therapy

• Goals panel
          • NEW ellipsis hover menu option added: Update Goal Progress. (Request) 12531
                    • Highlight a Goal, highlight the ellipsis and select Update Goal Progress.
                    • A Goal screen opens with the following fields:
                              • Progress – Enter information about the progress made towards the 
                                 highlighted Goal.
                              • % Achieved – Enter the achieved % (Example: 50).
          • Last Updated column added to the grid.
                    • Displays the last date the Goal Progress was updated.
          • Viewing Goal Progress:
                    • To view the information that was entered on the Goal Progress, highlight 
the 
                       Goal in the grid, highlight the ellipsis hover menu and select Edit.
                    • The Goals PopUp screen opens with a Goal Status Updates panel.

 (4/28/2023)(12.7.0.22) Tab(s) > EDITED: See Below

• The change below was made to the following tabs:
          • Tab Name: DiagEvalMSE, Tab Label: MentalStat
          • Tab Name: Plan, Tab Label: Plan
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Exam > Layouts & Tabs
          • Tab Name: PlanDiagEval, Tab Label: Plan
          • Tab Name: PlanMH, Tab Label: Plan
          • Tab Name: PlanwithAxis, Tab Label: PlanwAxis

• Diagnosis/Plan panel
          • Ellipsis hover menu
                    • The NEW option Quality Measures was added. When clicked, the LowRes 
                       Quality Measures tab is added to the end of the layout.

 (4/28/2023)(12.7.0.22) Tab(s) > EDITED: See Below

• The change below was made to the following tabs:
          • Tab Name: HiResDxMHPlan, Tab Label: Tx Plan
          • Tab Name: HiResDxPlan, Tab Label: Tx Plan
          • Tab Name: HiResPlanImages, Tab Label: PlanImages
          • Tab Name: HiResSess Note, Tab Label: Sess Note
          • Tab Name: HiResSessNotePsych, Tab Label: Psych Note
          • Tab Name: HiResSessNoteMH Tab Label: Sess Note
          • Tab Name: TreatPln, Tab Label: TreatPln

• Diagnosis/Plan panel
          • Ellipsis hover menu
                    • The NEW option Quality Measures was added. When clicked, the LowRes 
                       Quality Measures tab is added to the end of the layout.

 (5/16/2023)(12.7.0.22) Tab(s) > EDITED: See Below

• The change below was made to the following tabs:
          • Tab Name: PopUpISSPGoals, Tab Label: Goal
          • Tab Name: PopUpGoals, Tab Label: Goals

• Progress field
          • The field was expanded to allow for dated entries and notes.
          • Type the date, then enter down to document the Progress.
          • On the next visit, follow these steps:
                    • Put you cursor at the top/left of the field.
                    • Hit the Enter key to move the existing data down.
                    • In the new empty line at the top, type the new date.
                    • Enter down to the next line and document the Progress.
                    • If you would like an empty space between the current documentation and 
                       the last date, hit Enter again.
                    • This gives you a running list of the notes in one field.

Exam > Look-up Tables
 (4/28/2023)(12.7.0.22) Look-up Tables > EHR > Virtual > ADDED: Care Plan

• A NEW virtual table called Care Plan was added.
• Accessed by right clicking in the Name field of the new Care Plan tab.
• Field names:
          • Owner - Each entry has an assigned Owner, 'U' for User or 'C' for Compulink. 
                    • This allows Compulink to update our records without stepping on those 
                       you create.
                    • Owner 'C' records are not modifiable, but you can Hide them from 
                       Display.
          • Hide - A 'Y' Hides the item from display in drop-down lists. 
          • Display Order - Used to control the position of items in drop-down lists. Enter a 
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Exam > Look-up Tables
             number between 1 and 999998. Default is 999999 to display in the order 
             added to the table. 
          • Name – Name of Care Plan.
          • Major - Designate if the Care Plan is for a Major Treatment/Surgery. 
                    • Blank indicates Minor. 
                    • Added for E&M Coding changes.
          • Details – Description of the Care Plan. This can be multiple items. Example: Order 
             implant. Schedule Surgical Pre Op.
          • Care Plan Intent – Intent of the Care Plan. Example: Proposal, Order or Directive. 
          • Care Plan Category - Unique SNOMED identifier for the Category of Care Plan. 
             Example: Cancer care plan.
          • Status - Care Plan Status. Example: Active, Completed, etc.
          • Modified - Date this record was last modified; system generated and not 
             editable.

 (4/28/2023)(12.7.0.22) Look-up Tables > Encounter Favorites > Performed 
Functionality

• If you would like the Performed date to be automatically assigned when selecting the 
   Encounter Favorite, enter the following in the Default Values field: Performed=Value
• This defaults the Performed date with the Exam date. (Request)
• NOTE: This does not automatically populate the ID in the By field.
          • If you create Encounter Favorites using Location or Staff Groups, you may add 
             the PERFORMBY into the EF. Example: PERFORMBY=ABC
          • This automatically defaults the By ID to ABC.

Exam > Orders
 X (4/28/2023)(12.7.0.22) Orders > Display > Display Updates

• The following updates were made:
          • GUI changes to display rounded panels and fields.
          • Add/Edit/Delete buttons on the right were moved to an ellipsis hover menu.
          • NEW Orders icon at the top has replaced the ‘Save with Orders’ button.
          • NEW Save icon at the top has replaced the ‘Save without Orders’ button.
          • Use the ‘X’ in the top right to Cancel out of the window.
          • Table/List access was moved to ellipsis hover menus.
                    • Assessments – Assessment List Select
                    • Order Details – Order Set List Select
                    • Order Sets – Order List Select
                    • Plans – Plan List Select

 (5/26/2023)(12.6.0.18) Orders > Order Details > Care Plan

• You now have the option to add a Care Plan on-the-fly.

 (5/5/2023)(12.7.0.22) Orders > Order Details > Surgeries

• When adding a surgery via Orders, the Surgeon field defaults to the name of the user 
   currently logged into the software. (Request)

 (5/5/2023)(12.7.0.22) Orders > Order Sets > Care Plan

• Using Detail > Add gives you the option to attach a Care Plan to the Order Set. (Request)

 (4/28/2023)(12.7.0.22) Orders > Order Sets > Detail > Switch

• A Detail > Switch option was added.
• When selected, the window at the bottom changes to Location and Staff Control.
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Exam > Orders
• Use Detail > Add to connect a Location Group and/or a Login/Staff Group to filter the 
   Order Sets. (Request) 
• There is also an option to set the Display Order.
• With the addition of this option in the table, the following item was removed from Utility 
   > Location/Staff Filtering > Order Sets.

 (4/28/2023)(12.7.0.22) Orders > Order Sets > Hide Mode

• The Hide mode may now be used to hide Individual Orders.
• Click Hide then double click on Individual Orders to check the Hide field.

 (4/28/2023)(12.7.0.22) Orders > Order Sets > Individual Orders

• The height of the Individual Orders window was increased to allow display of more items 
   without having to scroll.

Exam > Utility
 (4/28/2023)(12.7.0.22) Utility > Location/Staff Filtering > All Options

• The enhancement below was added to Encounter Favorites, Layouts and Tabs.
• When selecting the Detail > Add command, a new ‘Table Filtering Control Editing’ window 
   opens with drop-downs to set the following: (Request) 
          • Location Group
          • Staff Group
          • Display Order

Function

Function > General & Display Changes
 (4/28/2023)(12.7.0.22) All > Display Changes

• All functions with a date parameter/option now have a drop-down calendar to select from.

Function > Account Statements
 (4/28/2023)(12.7.0.22) Account Statements > ExpressBill

• The following fields were added to System Setup/Configuration > Account 
   Billing/Statements to allow sending to ExpressBill to use Change Healthcare’s new SFTP 
   protocol.
          • ExpressBill Username – Practice’s Username for sending through ExpressBill
          • ExpressBill Password – Practice’s Password for sending through ExpressBill
• If the data is entered into these fields, when you run the Statement function with 
   ExpressBill checked as usual, the software automatically transfers the file via the new 
   protocol.

Function > Time Clock Review/Maintenance
 (4/28/2023)(12.7.0.22) Time Clock > Function Renamed

• The function ‘Time Clock’ was renamed to ‘Time Clock Review/Maintenance’ to better 
   describe what it is used for.

General
 (4/28/2023)(12.7.0.22) Display > Cancel Icon
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General
• The Cancel icon was changed to a trash can in the edit windows throughout the software.

 (4/28/2023)(12.7.0.22) Display > Screen Position

• When opening a screen, it now opens where the mouse is located.
• This helps reduce excessive mouse and eye movement. (Request)

 (4/28/2023)(12.7.0.22) Display Changes > Copyright Updated

• The Copyright date at the top of the screen now displays 2023.

Inventory
 (4/28/2023)(12.7.0.22) All > Search > Location Code

• In the Inventory Search window, the Location field now displays the Location Code along 
   with the name of the Location.

 X (4/28/2023)(12.7.0.22) Display > Several Items Updated

• The following updates were made:
          • GUI changes to display rounded panels and fields.
          • The following commands were removed from the toolbar as they now appear as 
             panels/grids at the bottom of the window:
                    • Adjust
                    • Orders
                    • Sales
                    • Xfer etc.
          • The following command was added to the toolbar:
                    • P.O. Locate
                              • Used to search for a purchase order #.
                              • This option used to be found on the Orders window.
          • The top panel now displays ‘Total On Order’ and ‘Patient Orders’.
          • The following panels/grids were added to the bottom of the window:
                    • Orders
                              • Ellipsis hover menu options: 
                                        • Add – Create an Order for the displayed Inventory item
                                        • Edit – Edit the highlighted record
                                        • Delete – Permanently remove the highlighted record
                                        • Receive – Receive the highlighted Order
                                        • Print – Print the Purchase Order for the highlighted record
                                        • Queue – Queue an Order for the Place Orders function
                              • Data displayed in the grid:
                                        • Ordered – Date Order record created
                                        • Qty – Quantity of items on Order record
                                        • Vendor – Vendor connected to Order
                                        • Acct# - Patient Account# Order queued for
                                        • Patients – Name of patient Order queued for 
                                        • Received – Date Order was received
                    • Sales
                              • Displays the Sales history associated with the specific Inventory item
                              • Data displayed in the grid:
                                        • Date – Date item was posted to the patient’s ledger using the 
                                           SKU/Stock#
                                        • Qty – Quantity of items sold
                                        • Acct# - Account# of patient item was sold to
                                        • Name – Name of patient item was sold to
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Inventory
                    • Adjustments
                              • Displays the Adjustment history associated with the specific 
                                 Inventory item
                              • Ellipsis hover menu options: 
                                        • Add – Create an Adjustment for the displayed Inventory item
                                        • Edit – Edit the highlighted record
                                        • Delete – Permanently remove the highlighted record
                                        • Receive – Receive a multi-site transfer
                              • Data displayed in the grid:
                                        • Date – Date Adjustment was made
                                        • Total – Quantity of items Adjusted
                                        • Xfer – A check indicates that the Adjustment was made due 
                                           to receiving a multi-site transfer
                                        • Type – Adjustment Type
                                        • Acct# - Account# of patient item was Adjusted for
                                        • Name – Name of patient item was Adjusted for
                    • Transfers, Repairs, etc
                              • Displays items that have been sent out for repair, loaned to patients 
                                 or transferred to another Location
                              • Ellipsis hover menu options: 
                                        • Add – Create a repair/loan/transfer record for the displayed 
                                           Inventory item
                                        • Edit – Edit the highlighted record
                                        • Delete – Permanently remove the highlighted record
                                        • Receive – Edit the highlighted record and enter the Received 
                                           By ID and On date (defaults to the current date)
                                        • Transfer – Used by offices operating in a Wide Area Network 
                                           (WAN) environment to transfer stock between Locations
                              • Data displayed in the grid:
                                        • Sent – Date item was sent
                                        • Qty – Quantity of items sent
                                        • Xfer – A check indicates that the was transferred to another 
                                           Location
                                        • Destination – Location Code item was transferred to
                                        • Received – Date item was sent

Ledger

Ledger > General & Display Changes
 X (12.7.0.22) Display Changes > Several Items Updated

• The following updates were made:
          • GUI changes to display rounded panels and fields.
          • Transaction History panel
                    • New panel added with the following items moved to the ellipsis:
                              • Print Receipt – Previously the printer icon
                              • Validate Claim – Previously the Claim Validate button

 (12.7.0.22) General > Right Click on Payment > Display Updated

• The following updates were made to the Credit Disbursement window:
          • GUI changes to display rounded panels and fields.
          • The ICN button was removed and the number (if available) now displays in the 
             header of the window to the right of Credit Disbursement.
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Ledger > Commands
 (4/28/2023)(12.7.0.22) Credit > Auto Resp Options > Faster

• When posting an Auto Resp. payment, the process now moves much faster to find the 
   first available line for posting. (Request)

 (4/28/2023)(12.7.0.22) Edit > Opens At Mouse Location

• When editing a Ledger entry, the window now opens at the location of mouse placement.
• Example: Mouse is over the Activity field when double clicked, window opens there. 
   Mouse over Balance field on the far right, it opens to the far right.
• This brings the window up in the area where the user was already focused on.

 (4/28/2023)(12.7.0.22) Options > ADDED: ReCalculate Ledger

• The option ReCalculate Ledger was added.
• When selected, it runs Ledger Validation on the entire Ledger.

 (4/28/2023)(12.7.0.22) Options > ADDED: Update RCM Configuration

• The option Update RCM Configuration was added.
• This NEW option contains fields that are for RCM reference only.
• Only Compulink RCM employees have access if assigned Full Rights under Login Profiles.
• The fields are for reference only and don’t control any functionality in the software:
          • RCM Point of Contact
                    • Point of Contact the practice has assigned to handle RCM.
                    • Use the drop-down to select from the Login IDs table.
          • RCM Start
                    • Date the practice started using Compulink’s RCM Services.
          • # of Business Days to Hold Claims before sending
                    • Under Function > Insurance Activities > Billing, the Threshold defaults to 
                       the current date.
                    • If the practice wishes to hold claims before billing, the number of days to 
                       hold is entered in this section for the RCM Representative to reference.
                    • When accessing the Function, they can adjust the date accordingly.
          • The Day of the Week ExpressBill Statements are Uploaded (Sunday=1)
                    • Reference for the practice’s preference for when Statements should be 
                       uploaded.
          • ERA Wait Period After Check Received (days)
                    • Practice preference for how long to wait after receiving a check to post it to 
                       the Advantage software.
                    • Most accounts have a 3 day or less threshold.
          • RCM Notes
                    • Memo field to enter general notes about the practice’s RCM services.

 X (4/28/2023)(12.7.0.22) Options > Recalc Renamed

• The Option Recalc was renamed to Insurance Paid % Update to better describe what the 
   Option is used for.
• Highlight to display the same options of Line Only and Line Forward.

 X (4/28/2023)(12.7.0.22) Options/View > Items Moved

• The following items were moved from the Options command to the View command for 
   better usability:
          • View Account Aging moved and renamed to Account Aging
          • View Archive moved and renamed to Archived Records
          • View Line Item Detail moved and renamed to Line Item Detail

 (4/28/2023)(12.7.0.22) Print > Portal > Receipt/Statement

Compulink Healthcare Solutions | 1100 Business Center Circle | Newbury Park, CA 91320 | 805.716.8677 .
elearning@compulinkadvantage.com | www.compulinkadvantage.com               25



Ledger > Commands
• If the user does not have On-Line Bill Pay set up with the Advantage software, the 
   following message displays: Statement and Receipt Upload to Patient Portal Requires 
   Portal On-Line Bill Pay to be Turned On!

 (4/28/2023)(12.7.0.22) View > ADDED: RCM Configuration

• The view RCM Configuration was added.
• Only Compulink RCM employees have access to this view.
• It displays the information that was entered under Options > Update RCM Configuration; 
   NEW Login Right required to update.
• It allows RCM staff to view the information only and not make changes.

Look-up Tables

Look-up Tables > EHR
 X (5/10/2023)(12.7.0.22) EHR > Patient Assessments > New Menu

• A NEW menu option ‘Patient Assessments’ was added.
• The following tables were moved from ‘Assessment/Plan’ to the new ‘Patient Assessments’
   menu:
          • Category
          • Name

Look-up Tables > General
 (5/5/2023)(12.7.0.22) General > Labs > List > ADDED: See Below

• The ‘Display Order’ field was added to the table.
• Used to control the position of items in drop-down lists. 
• Enter a number between 1 and 999998. 
• Default is 999999 to display in the order added to the table.

 (5/25/2023)(12.7.0.22) General > Provider > ADDED: Exam Encounter Filter

• The ‘Exam Encounter Filter’ field was added to the table and defaults to ‘None’.
• Designate which Exams/layouts are seen by the Provider upon first entering the Exam, as
   well as when clicking Back/Next in Exam.
          • Defaults to ‘None’ to view all.
          • Episode – Displays the most current Exam record connected to the active Episode, 
             and follows that Episode when clicking Back/Next. 
                    • User still has the option to use the Locate command and view records not 
                       connected to the active Episode.
                    • If one of these records is selected, it stays in the list that is viewed when 
                       clicking Back/Next, until the patient is refreshed.
          • Specialty Specific – In Development
• If the user logged in is a Scribe, the filter connected to the Provider chosen upon Login is 
   used.

Patient

Patient > General & Display Changes
 (4/28/2023)(12.7.0.22) Display > Today's Appointments

• The Today’s Appointments grid was updated to allow the user to click on a column header 
   to sort the list. (Request)
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Patient > General & Display Changes
 (4/28/2023)(12.7.0.22) General > Data Entry > Primary Language

• The drop-down no longer displays in usage order, as the user has access to right click in 
   the field, open a table and set their own Display Order. (Request)

 (5/23/2023)(12.7.0.22) General > Data Entry > Scanned Documents > Import

• If the Scanned Documents grid is empty, when you highlight the ellipsis hover menu, the 
   option for ‘Import’ was added. (Request)

 (4/28/2023)(12.7.0.22) General > Data Entry > Valid E-Mail

• Upon saving the patient record, the software checks for a valid E-Mail format.
• If the format is incorrect, the following Error displays: Bad E-Mail Address!
• Click ‘OK’ and enter the E-Mail in the correct format.

 (4/28/2023)(12.7.0.22) General > Data Entry > Zip Code

• If the City field is empty, when you enter a zip code and exit the field, the software 
   populates the City and State fields. (Request)

Patient > Commands
 (4/28/2023)(12.7.0.22) Delete > Date Drop-Down

• When deleting a patient, you are prompted to enter the current date to confirm.
• Requiring the user to change this date prevents inadvertent deletion of patient records.
• The date field now has a drop-down to access a calendar to select from (you no longer 
   have to be concerned with typing the date in the correct format).
• Default date is the current date minus 60 days.

 (4/28/2023)(12.7.0.22) Documents > Import > File Type Filter

• When importing a document, the file type field defaults to ‘Document Files 
   (*.JPG;*.PDF;). (Request)

 X (4/28/2023)(12.7.0.22) Insurance > Display > Several Items Updated

• The following updates were made to the Search window:
          • GUI changes to display rounded panels and fields.
          • Insurance card scan fields:
                    • These were moved to the bottom of the screen.
                    • All buttons were moved under the ellipsis hover menu (Scan/Import/Rotate 
                       90/Print).

 (4/28/2023)(12.7.0.22) Jump > Chart > Command Removed

• The option to Jump to Chart was removed as Chart Tracking is no longer used by clients.

 (4/28/2023)(12.7.0.22) Jump > Task > Add/Edit > Items Updated

• The following updates were made to the Add/Edit window:
          • GUI changes to display rounded panels and fields.
          • Items were grouped onto 2 panels: Task and Update.

 (4/28/2023)(12.7.0.22) Jump > Task > Edit

• Editing a Task no longer requires entering a ‘Note’ to save.

 (4/28/2023)(12.7.0.22) Jump > Todo > Command Removed

• The option to Jump to Todo was removed as this information can be accessed from the 
   ‘Patient Action Items’ grid on the demographics.
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Patient > Commands
 (4/28/2023)(12.7.0.22) Print > Letter > Window Updated

• The following updates were made:
          • GUI changes to display rounded panels and fields.
          • NEW Document and Options panels.
          • The OK button was replaced with a Proceed button on the command bar.
          • The Cancel button was removed, as you can use the X in the top right to cancel 
             and close the window.

 (4/28/2023)(12.7.0.22) Recall > Command (Add) > Items Updated

• The following updates were made to the Add/Edit window:
          • GUI changes to display rounded panels and fields.
          • Fields were rearranged for a better usability flow: Date, Reason, ID, Loc, Dept, 
             Last Sent and # Sent.

 (5/23/2023)(12.7.0.22) Referral > Type Ahead for Search

• The Business field now offers the type ahead feature. (Request) 
• Type a few characters then click the drop-down to only display results where the 
   characters match in the ‘Name’ field of the Referral Source in the table.

 X (4/28/2023)(12.7.0.22) Search > Display > Several Items Updated

• The following updates were made to the Search window:
          • GUI changes to display rounded panels and fields.
          • Patient panel
                    • Mid Init. Field changed to MI

 (8/1/2023)(12.7.0.22) Utility > CCD Patient Connect > Delete Option

• The user now has the option to delete a CCD if it doesn’t match up with a patient in their 
   software (possibly sent to your practice in error). (Request) 
• After selecting the CCD from the list, click ‘OK’ on the following Warning: Unable to locate
   any records for current search criteria! Please change criteria and try again!
• In the ‘Select Patient’ window, you may search for a matching patient.
• If no match is found, hit the Esc key on the keyboard to close the search window.
• Click ‘OK’ on the following message: Would you like to Create NEW Patient Record for: 
   patient name
• Click either ‘Yes’ or ‘No’ on the following message: Select YES to Confirm DELETION of 
   CCD for : patient name
          • No – Keep the CCD and start over.
          • Yes – Delete the CCD from the list.

 (4/28/2023)(12.7.0.22) Utility > CCD Patient Connect > View CCD

• After selecting a CCD from the list, you now have the option of viewing it prior to 
   selecting a patient to connect it to.
• Select the CCD, then click ‘Yes’ on the following message: Select YES to Review CCD 
   before Patient Connection Attempt to: patient name?
          • The patient name is pulled from the CCD.
• The ‘Continuity of Care Document “CCD” Viewer window opens to review the information.
• Click the ‘X’ to close the viewer.
• Click ‘OK’ on the following Warning: Unable to locate any records for current search 
   criteria! Please change criteria and try again!
• The ‘Select Patient’ search window opens and the Last, First field defaults with the patient
   name from the CCD.
• Click the ‘X’ to close the search window.
• The following message appears: Would you like to Create NEW Patient Record for: 
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Patient > Commands
   patient name
          • Select ‘No’
                    • Displays the following to select ‘Yes’ or ‘No’: Select YES to Confirm 
                       DELETION of CCD for: patient name
                    • Selecting ‘Yes’ to this message removes the CCD from the list.
          • Select ‘Yes’
                    • Creates the new patient record and connects the CCD.

Patient > Layouts & Tabs
 (4/28/2023)(12.7.0.22) Tab(s) > EDITED: See Below

• The change below was made to the following tabs:
          • Tab Name: Patient (HiRes+Episode P), Tab Label: Patient

• Patient Action Items panel
          • Ellipsis hover menu
                    • Print – NEW option added. When clicked, the Report Viewer opens with the 
                       list of ToDo Action Items for the active patient.

Printer & Output Tools
 (4/28/2023)(12.7.0.22) GUI Customize > ADDED: Grid Historical Color

• The NEW field ‘Grid Historical Color (EHR Only)’ was added with default color dark gray 
   (#5987163).
• This controls the font color of the historical records in the EHR Sub-table grids.
• Records for the current Exam display in black font, and historical records display in this 
   dark gray font (5987163).

 (4/28/2023)(12.7.0.22) Workstation Configuration > Window Updated

• The configuration window was changed from 2 tabs to a column format.
• The following fields were renamed for better usability:
          • Misc tab
                    • Business Location to Location
                    • Patient Tracking Stop to Tracking Station Name
                    • Legacy Workstation Name to Name
                    • Cash Drawer Com Port to Cash Drawer Port
                    • Patient Face Twain Device to Patient Camera driver
                    • Ins. Card Twain Device to Insurance Card Scanner driver
                    • Document Twain Device to Document Scanner driver
                    • Exam Image Twain Device to Image Scanner driver
                    • Exam Signature Device to Signature Device driver
                    • Drawing Twain Device to Drawing Device driver
                    • Visual Documentation Engine:
                              • Dot Icons to VDE Dot Only
                              • Tablet Mode to VDE Force Tablet
                              • Camera Type to VDE Camera Config
                    • Screen Display Scale % to Screen Scale
                    • Credit Card Reader ID# to Credit Card Reader ID
          • Instruments tab
                    • #1 - #5 to Name of Interface #1 – Name of Interface #5
                    • Port to Port # for Interface #1-#5
                    • Usage to Usage Indicator for Interface #1-#5
                    • WAN – Removed as it is no longer used
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Reports

Reports > Appointment
 (4/28/2023)(12.7.0.22) Appointment > Analysis > ADDED: Utilization with 

Options

• Report reviews Appointment time-slot usage (either Booked Appointment or Blocked 
  time) in schedules that were set up via Appointment > Utility > Template Schedule.
• The Chart, Summary and Detail displays are similar to the standard Utilization report, 
   however, this report includes more options for filtering. (Request)

 (4/28/2023)(12.7.0.22) Appointment > Daily > EDITED: Missing Charges

• Report changes:
          • If for some reason the patient name is missing from the Appointment record, that 
             record does not display on the report. (Request)

Reports > Financial
 (4/28/2023)(12.7.0.22) Financial > Analysis > ADDED: Payments by Auxiliary 

Provider

• The report is an Auxiliary ID based summary similar to the Payments by Provider report. 
   (Request) 
• The Auxiliary Provider name is as it is noted from the Login ID Full Name field.
• <n/a> displays for payments applied to charges with a blank Aux ID.
• <Unapplied> displays for the unapplied portions of the payment.
• The report has a summary by Auxiliary Provider as well as an overall Location summary.
• Detail includes transaction detail by Auxiliary Provider, by post date.

Reports > Recall
 (4/28/2023)(12.7.0.22) Recall > EDITED: Recall/Reactivation List

• Report changes:
          • PHONE – If the patient Home Phone is blank, the Cell Phone merges. (Request)

Utility > System Administrator
 (4/28/2023)(12.7.0.22) System Administrator > Dictionary Utilities > ReIndex 

Individual Table

• The user now has the option to instantly ReIndex the table, or to queue it up for 
   PracticeWatch to run it at night to avoid a slowdown in software performance.
• This also allows clients that are Cloud-based to queue ReIndex without the help of 
   Compulink’s Cloud IT department.
• REMINDER: The practice MUST be running Advantage Database Server version 12 to 
   utilize this utility.
• Queuing a ReIndex:
          • Select Dictionary Utilities > ReIndex Individual Table.
          • Click ‘Yes’ on the following Warning: OnLine Indexing while Application in use may 
             affect System performance! Would you like to continue?
          • Enter your search for the table, click ‘OK’ and select the table.
          • Click ‘No’ on the following message: Select YES to Reindex NOW or NO to Queue 
             up Table Reindexing to Occur Tonight and AVOID Performance SLOWDOWN!
          • Select other tables if needed, otherwise click ‘Cancel’ on the search window.
          • Click ‘OK’ on the message: Application must be exited and restarted before newly 
             created Indexes on Selected Table(s) will be utilized for any/all Users!
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Utility > System Administrator
 (4/28/2023)(12.7.0.22) System Administrator > Dictionary Utilities > 

ReIndex/Pack

• The following information applies to the Utilities Pack Individual Table, ReIndex Individual 
   Table and ReIndex/Recalculate in Bulk.
• The practice MUST be running Advantage Database Server version 12 to utilize this utility.
• These utilities don’t require all users to exit the software, but they should be run when 
   the majority of users are out, such as end of day.
• For the processes to complete, there must be a moment when the selected table (Patient,
   Exam, Ledger, etc.) is not being accessed by users or an API.

 (4/28/2023)(12.7.0.22) System Administrator > Dictionary Utilities > 
ReIndex/Recalculate in Bulk

• This was formerly under Utility > Diagnostics.
• Due to this being updated to run while other users are in the software, the following 
   message no longer displays in the detail window when running: ***END of Exclusive 
   Access Section of Diagnostics***
• REMINDER: No more than one computer at a time should be running this utility.

 (4/28/2023)(12.7.0.22) System Administrator > Dictionary Utilities > Re-
Index/Recalculate in Bulk > Message

• If this utility is running on one workstation, and a user attempts to run it on another, the 
   following message displays upon clicking Begin: ReIndexing/Recalculation is in use on 
   Network!

 (4/28/2023)(12.7.0.22) System Administrator > Login > IDs > Required E-Mail

• The following items were updated for IDs with Owner, Manager or Provider checked:
          • Primary E-Mail is required.
                    • The following Warning displays if E-Mail is left blank and trying to save the 
                       record: Owners/Managers/Providers Require Primary E-Mail!
          • Primary E-Mail is in a valid format.
                    • The following Warning displays if E-Mail is not in a valid format and trying to
                       save the record: Illegal E-Mail!

 (4/28/2023)(12.7.0.22) System Administrator > Login > Profiles > New Right

• The following NEW Login Profile Right was added: Update RCM Configuration.
• Options are None and Full; default is None.
• If assigned Full, and the Login ID that the Rights Profile is attached to belongs to a 
   Compulink RCM employee, they have access to the NEW option in the Ledger: Update 
   RCM Configuration.
          • The new option contains fields that are for RCM reference only.
          • See the following section in this document for details: Ledger > Commands.

 (4/28/2023)(12.7.0.22) System Administrator > System Setup/Configuration > 
Account Billing/Statements > EDITED: Country

• The Country field was updated to allow ‘JAM’ for Jamaica.

 (4/28/2023)(12.7.0.22) System Administrator > System Setup/Configuration > 
Account Billing/Statements > EDITED: See Below

• Use Claim Set from Previous Encounter (Request) 
          • This is a NEW field that allows the user to control if the software defaults to using 
             the previous Claim Set when posting charges.
          • Default is unchecked – Creates a new Claim Set for each Date of Service.
          • Checked – Defaults the Claim Set from the previous visit when posting new 
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Utility > System Administrator
             charges. User has the option to click ‘New’ to create a new Claim Set.

 (4/28/2023)(12.7.0.22) System Administrator > System Setup/Configuration > 
Account Billing/Statements > EDITED: See Below

• The following fields were added to allow sending to ExpressBill to use Change 
   Healthcare’s new SFTP protocol. (Request) 
          • ExpressBill Username – Practice’s Username for sending through ExpressBill
          • ExpressBill Password – Practice’s Password for sending through ExpressBill
• Run the Statement function with ExpressBill checked as usual and the software 
   automatically transfers the file via the new protocol.

 (5/23/2023)(12.7.0.22) System Administrator > System Setup/Configuration > 
Appointment > ADDED: Next Selection Behavior

• The option ‘Next Selection Behavior’ was added and is tied to the selection of the Next 
   command in the Appointment Scheduler. (Request) 
• Based upon the selection here, the software performs in the following manner:
          • Follow Provider – Go to the next day for the same Provider, regardless of the 
             Location.
          • Follow Location – Go to the next day schedule for the same Location, regardless of 
             the Provider.
          • Follow Loc & Provider – Go to the next day schedule for the same Provider at the 
             same Location.
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